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1. CELL COMMENTS 

CREATE, EDIT AND DELETE COMMENTS 

Comments are a small note attached to a cell; they can be 

used to remind the user of some information or can act as 

an instruction between the spreadsheet designer and the 

end user.  

To create or add a comment to the current cell go to the 

Review tab to the Comments group and click on New 

Comment (or right click on the cell and select Insert 

Comment). This will add a comment to the cell showing the 

name of the editor in the top of the comment.  

NOTE: Cells containing a comment are marked with a small red triangle in the top right hand 

corner of a cell. To view comments select a cell with a comment in it.  

To edit or delete a comment, select the cell 

with comment in it and choose the relative 

option from the Comments group on the 

Review tab (or right click on the cell). 

DISPLAY COMMENTS 

Comments are not normally displayed on the spreadsheet and do not usually print.  To display a 

comment or comments at all times: select the Show/Hide Comment to turn on one comment for 

a selected cell, or select Show All Comments to turn on all comments in a worksheet.  

To print comments: display the comments required for printing and go the Page Setup dialgoue  

under the Sheet tab in the 

Comments: drop down box choose 

the appropriate option (usually As 

displayed on sheet as shown).  
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2. LINKING AND IMPORTING 

CREATE AND EDIT HYPERLINKS 

Hyperlinks can be added to documents to link files, websites, bookmarks, email address and 

worksheets.  

This can be done in two ways:  

1. Go to the Insert tab to the Links group and click on the Hyperlinks command.  

This opens the Edit 

Hyperlink dialogue 

box, select where the 

link will be made to 

and browse to the 

correct file or paste 

the URL (website 

address) and click ok.  

NOTE: Text to Display at the top of the dialogue box.  

2. Use the function HYPERLINK which has two arguments:  

=Hyperlink(link_location,friendly_name)  

The Hyperlink function uses the file path in “inverted commas” as a link_location, followed by a 

given friendly name also in “inverted commas” (this function can also be used with a URL or 

email address as the link_location).  

NOTE: If a file path is renamed or changed the hyperlink will not be able to locate the required 

file.  

Both methods create a hyperlink in a cell that can be clicked on to open the file or website.  
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LINK BETWEEN WORKSHEETS 

Data can be used across different worksheets in a variety of ways.  The most simple method is to 

use the = and click on the worksheet and cell required, this will bring in the worksheet name 

(surrounded by ‘apostrophes’ and followed by an exclamation mark!) and 

the cell reference of the linked cell.  

Example ='Financial Functions'!E18 

Another method is to copy and paste the information using the Paste Link 

or paste Linked Picture from the Paste drop down menu on the Home tab 

as shown here. 

The data will always be automatically updated in the destination 

worksheet using both of these methods.  

LINK BETWEEN WORKBOOKS 

Information can be linked between workbooks by creating a link to an external reference; this 

can be a cell reference, a range reference or a named range.  External references are used when 

working with large amounts of data or complex formulas that are spread across several 

workbooks. The spreadsheet the information is taken into is known as the destination file. 

The following example shows an external link to an open excel document with a SUM function: 

=SUM(‘[Budget.xlsx]Annual’!C10:C25)  

Notice apostrophes around the workbook and worksheet name, the workbook name is in 

[square brackets] the worksheet name is followed by an exclamation mark and the cell range is 

included.  

If the external source excel document is not open the full file path should be included as follows: 

=SUM('C:\Reports\[Budget.xlsx]Annual'!C10:C25) 

When the external source includes a named range the external link will appear as follows: 

=SUM(‘Budget.xlsx’!Sales) 

To include an external link open both workbooks and click on the cell range to be included in the 

formula – the file path and range will be added automatically.   
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LINK DATA TO OTHER APPLICATIONS, E.G. WORD AND ACCESS 

Data or charts can be linked into another application from Excel.  For example a table or chart 

can be pasted into a Word document. To ensure the data in the Word document updates after it 

has been pasted the information can be set to dynamic linking. To do this, ensure the content is 

pasted as linked object.  

1. Highlight the data to be copied from 

Excel and select copy.  

2. Open the Word document where the 

information will be pasted and choose 

the Paste drop down, from the Paste 

Options: select Link & Keep Source 

Formatting (F) as shown.   

 

 

 

3. If the information is updated in Excel and needs to 

be updated in the Word document open both files 

and right click in the Excel document and select 

Update Link as shown.  

 

 

NOTE: By default, linked objects are updated automatically. This means that Word updates the 

linked information every time the Word file is opened or any time the source Excel file changes 

while the Word file is open. 

  

NOTES: 
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IMPORT DATA FROM OTHER APPLICATIONS, E.G. WORD AND ACCESS 

To import data from another 

application go to the Data tab to the 

group Get External Data.  Depending 

on the source of the data, choose the 

correct Application and browse to the 

data source location.  

 In this example data will be imported from a text file.  

1. Click on the From Text 

button and the Import 

Text File window will 

appear.  

2. Browse to the location of 

the text file being 

importing, select the file 

and click on import.  

 

 

NOTE: When importing data from a text file it is important to notice how the data is set up in the 

file.  In this text file the data is separated by tab spaces or Tab Delimited as shown here.  Data 

can also be separated by a single space, colons.  

  



Section 3: Worksheet Features 

 

 

 
Page 7 

 
  

These notes have been compiled by Rynagh McNally for students of Monaghan Institute.  

Follow the three steps to import data: 

 

Step 1 – if the data is set up 

correctly (with tabbed spaces) in 

the text file, the wizard should 

detect that it is delimited.  The data 

should be visible in the Preview of 

File.  

Select Next.  

 

 

Step 2 – select how the data is 

delimited (spaced out).  In this 

example the data is delimited by 

tabs however semicolons, commas, 

spaces or another symbol could be 

used.  Check the Data Preview to 

ensure the data looks correctly 

separated into columns. Select 

Next.  

 

 

Step 3 – set the data type of each 

columns.  Click on each column in 

turn by selecting the grey heading 

and choosing the correct data type. 

Select Next.  
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The data should be imported into the Excel 

spreadsheet separated into appropriate 

columns and cells and without formatting as 

shown.  

 

 

 

 

 

 

 

3. LISTS 

FILTER LISTS 

Filtering is applied to lists of data, the result of a filter displays only the rows that meet the 

criteria specified and hides rows that do not need to be displayed. Showing only the information 

required. After filtering has been applied the data can be copied, formatted, printed and put into 

a chart without having to rearrange or move it.  

Filtering can also be applied in more than one column. Filters are additive, which means that 

each additional filter is based on the current filter and further reduces the subset of data. 

Three types of filter can be applied to data: filter by values, filter by format or filter by criteria. 

Each of these filter types is mutually exclusive for each range of cells or column table. For 

example, filtering can be applied by cell color or by a list of numbers, but not by both; it is 

possible to filter by icon or by a custom filter, but not by both. 

 

  

NOTES: 

NOTE: it is very important to ensure the first row of the information to be filtered has headings, 

filtering without headings can be confusing. In addition ensure that the data to be filtered has 

no gaps in the information. This could lead to the wrong result after the filter, where rows have 

been left out unintentionally. 
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AUTOFILTER – FILTER IN PLACE 

To use the AutoFilter click into the table and go to the Data tab to the Sort & Filter group and 

select the Filter button, the filters will automatically be turned on for each of the headings in the 

table (this will also work if entire table area is selected before turning on the Filter).  

There are three types of filters that can be used they are text, date and number. Filters are 

applied differently depending on the data to be filtered. 

 

 

 

 

 

 

Complete the following filters: 

1. Filter the Fruit by Apples and 

Oranges as shown.  

2. Sort the Fruit A to Z from the filter 

drop down.  

3. Sort by the Colour Green, Orange, 

Brown as shown.  

 

 

 

 

  

NOTE: With Text filters if a heading has two different spellings or has a space after it in a 

column, the auto filter will pick up both headings. Try to ensure there are no spelling errors in 

worksheets to avoid this problem.  

Filters can also be applied 

according to the colour of the cell 

- font or background 

Experiment with the Resource on 

Filtering – Fruit and Veg.
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REMOVE A FILTER 

To remove any filter that has been applied first click in the table anywhere, then go to the Data 

tab to the Sort & Filter group and deselect the Filter command button.  

Alternatively click on the heading which has a filter applied to it. The filter symbol will have 

changed to this   and from the filter list select the Clear Filter From: option. 

 

  

 

 

 

 

 

 

 

  
NOTES: 
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CUSTOM AUTOFILTER – TEXT, DATE AND NUMBER 

TEXT 

Use the search box in Custom Filter to 

apply very specific criteria. For example 

in a TEXT filter it might be required to 

find a salesperson with the name 

containing with the letters ‘Ja’, in the 

Search box on the filter drop down 

menu type the letters. This will filter all 

the appropriate information.  

 

 

 

 

 

 

The following wildcard characters can be used as comparison criteria for text filters. 

Use To find 

? (question mark) Any single character 

For example, sm?th finds "smith" and "smyth" 

* (asterisk) Any number of characters 

For example, *east finds "Northeast" and "Southeast" 
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DATE 

Custom Filters can also be used for DATE filters. In 

this example the month of May is custom searched 

in the Date column. The filter list automatically 

shows all the available dates showing May, when 

applied only sales in May are shown. Clicking on 

the plus symbol next to the month will show all the 

available days in that month.  

 

 

 

 

In addition using a number here will bring up all the dates with that number in them. For 

example typing 4 – will give any dates with 4th 14th or 24th. 

The following wildcard characters can be used as comparison criteria for number filters. 

Use To find 

*4 This will show any number containing a 4 anywhere in the number.  

?4* This will show any value starting with the number 4.  

?1,* This will show all values that start with one thousand – 1,???.  

Date filters can also be applied in preset group 

categories as shown here. In this example the filter 

will show all orders places Last Year.  

There are a variety of different options here for date 

filters. Some of these options can be filtered further, 

for example the Between… filter can be used to set 

two specific dates.    
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NUMBER 

To apply a Custom Filter to a NUMBER there are a variety of options experiment with some of 

these options to understand how they behave. Notice that those options with the three dots 

after them for example Greater than… will open a Custom Auto Filter dialogue box to allow the 

required figures to be set (see below).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ADVANCED AUTO FILTER TO EXTRACT FILTERED DATA 

An advanced filter is similar to a normal filter, the main difference is that the information is 

filtered using criteria and the filtered information is filtered out to a new location instead of 

remaining in place. It is very useful for Extracting information. 

To use the advanced filter again it is very important to have the data correctly set up. No spaces 

(missing information) in the data and no blank lines.  Set up the criteria range above the data set 

as shown on the next page.  
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ONE CRITERIA  

In this example the Criteria range is cells A7:D8 and the List range is cells A10:D47.  

 

 

 

 

 

 

 

 

 

 

 

 

Before using the Advanced Filter first type in the criteria to be filtered, in this example the word 

Tommy is in cell C8 as we want to find all the sales completed by Tommy and extract this data to 

another location or list. 

Next click anywhere in the List Range (this ensure the list range is automatically selected), to 

access the Advanced Filter go to the Data tab to the Sort & Filter group 

and select the Advanced button, this will open the Advanced Filter 

dialogue box.  

In this example the list range is automatically selected as 

A10:D47, the criteria range is A7:D8 (to select this click in the 

criteria range text box and highlight the range).  The Copy to 

another location radio button is selected, this turns on the 

Copy to: option, in this example the filtered data will be 

copied to cell F28. To apply the filter click ok.  

Criteria Range List Range 
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This results in the filtered data being extracted from the list range starting at the cell F28 as 

shown.  

 

 

 

 

 

 

 

 

 

 

Note that when the cell references are entered into the Advanced Filter dialogue box they 

automatically have absolute cell referencing applied to them. The Criteria and Extracted Range 

of cells are automatically to the Name Manager (this will be discussed in detail in the next point 

4 Naming Cells).  

MULTIPLE CRITERIA – AND 

To filter a list range by more than one criteria the same Advanced filer method can be used.  The 

difference with multiple criteria is that in the criteria range, more than one criteria is added 

along one line (by keeping the criteria along one line a AND filter is applied).  

In this example the advanced filter will find sales by 

Susan, after the 01/01/2011 which were greater than 

€500. Note that the > Greater Than symbol is used along 

with the criteria. The resulting filter will be extracted to 

cell G12.  

This is an AND criteria all 3 criteria must be met for the 

filter to show a result.  

 

Extracted Filtered Data 
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Note the Criteria range has three criteria and the extracted filtered data meets all of these 

criteria.  

 

 

 

 

 

 

 

MULTIPLE CRITERIA – AND WITH A RANGE  

In this example the criteria heading Amount has been used twice. This can be used on cells which 

have a number value or a date range (not on text). All of the sales made by Susan after 

01/01/2011 that were less than €1,000 but greater than €500 are shown. Note that the criteria 

range has two Amount headings - <1000 and >5000.  

 

 

 

 

 

 

 

This type of example could be used on dates to extract all sales from the 1st of January in any 

year to the 31st December, by adding two date column and adding >01/01/2011 and 

<31/12/2011. This could also be used to exclude a particular year by reversing the symbols.  
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MULTIPLE CRITERIA – OR 

In this example the multiple criteria uses two lines, this will mean the two rows of filters are 

applied to the data simultaneously.  So in this example we can see the data for Susan or Mary 

Jane and the sales they have made after the01/01/2011 that were greater than €500.  

 

 

 

 

 

 

 

 

 

 

 

 

 

ADVANCED FILTER OF UNIQUE RECORDS 

Advanced Filtering can also be used to remove unique values from a list to summarize it to one 

value no matter how many times it is repeated on a list. For example if a list of the sales team 

staff from the Salesperson column over the last three years was required, this technique could 

be used to prevent searching the list manually.  

When selecting the data for this technique only the column containing the information needs to 

be highlighted for the List range. 
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To use this technique highlight the column to be filtered as 

the List range, in this example that is the Salesperson 

column.  

Don’t select a Criteria range - this should be left blank as 

we have no criteria this time. Select a Copy to location, to 

allow the list to be extracted and not copied in place. 

Finally tick the box next to Unique records only to ensure 

the data is not repeated as it is in the list.  

This will result in a separate list of the sales staff with each member of the staff only showing 

once. This list can then be sorted alphabetically if required.  

 

 

 

 

 

 

  

NOTES: Visit Excel is Fun by Mike Girvin for more information on Advanced Filtering.  

https://www.youtube.com/watch?v=SU1qGbN6Rs8
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ADD SUBTOTALS TO FILTERED LISTS 

After a list has been filtered is can be very useful to have a subtotal of the new filtered 

information. There are two methods of achieving subtotals for filtered lists the SUBTOTAL 

Formula and Outline Subtotals. The first is the formula which will be covered now and will 

appear again in Section 4 – Formula and Functions. 

SUBTOTAL FORMULA 

In this example the sales for 2013, 2012 and 2011 amount to €72,358. Only the sales for 2012 are 

required and a new subtotal for just this year is required. The normal SUM formula will show the 

total for all rows in the range even after a filter is applied, this is why the SUBTOTAL formula is 

required. 

The SUBTOTAL formula has two arguments the first is the function_num which determines the 

type of calculation to be completed by the formula. As this is adding SUM is required which is the 

number 9.  The second argument is the full range of the cells to be calculated before the filter 

has been applied, in this example that is the range D9:D45. 
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The result of the subtotal formula after a filter has been applied on the year 2012 is as follows:  

 

Note that the rows are not sequential which shows the filter has been applied and the subtotal is 

€14,806.00.    

 

 

 

 

 

 

 

 

 

 

 

  

NOTES:   
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4. NAMES 

NAME A CELL 

A Name is a meaningful shorthand of the contents of a cell that makes is easy to understand at a 

glance. Using names on cell can make formula easier to understand, names can be defined for 

individual cells or for whole ranges. After a cell has been named this name can be used in any 

formula.  

When choosing a name for the cell ensure it is unique to Excel for example, Today cannot be 

used as a name because this is the name of a function in Excel. Names cannot contain a space, 

cell references cannot be used as the name of a cell, up to 255 characters can be used and names 

can contain upper and lower case letters.  

To set the name of a cell select or 

click on the cell to be named (this 

step is often overlooked if the cell is 

not correctly selected the wrong cell 

will be named)  – in this case it is cell 

C7  

In the Name Box type the name to 

be applied - TaxRate and press the 

enter key.  

After a cell has been named the Name Box can be used 

to quickly access the cell, to do this, click on the down 

arrow to the right of the name box and select the name 

of the cell. This will bring the cursor to the named cell 

from any worksheet.  

  

Name box 
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NAME A RANGE OF CELLS 

In the same way a single cell can be named a range of cells can be named, this applies to both 

adjacent and non-adjacent groups of cells. 

Again this allows them to be easily found and 

highlighted with the name box, and allows 

ease of use of the range within functions and 

formula.   

To apply a name to a range of cells highlight 

the range of cells to be named, click on the 

name box, type in the name of the range of 

cells and press the enter key.  The name will 

appear in the name box.  

Remember that there should be no spaces used in a name box.  To identify a range with two 

words use an underscore between them e.g. Tax_rate.   

USE NAMES IN FORMULAS 

Named ranges can also be used in 

formula and functions instead of 

cell references e.g.  

 =Tax + Cost 

 =SUM (tax) 

Note: Another important feature of a named range is that it doesn’t change when a formula is 

auto filled.  Therefore it provides an alternative to using absolute cell referencing in functions 

and formula.  

NAME MANAGER 

The Name Manager can be used to create, edit, delete and find all the names used in the 

workbook. To access the Name Manager go to the Formulas tab to the Defined Names group 

and click on the Name Manager command. Alternatively use the keyboard shortcut Ctrl + F3. 

Name box 
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This will open the Name Manager dialogue box which displays a list of all of the named cells or 

ranges in the workbook.  

 

DELETE OR EDIT A NAMED CELL OR RANGE 

To delete a range open the Name Manager (using the method above or the shortcut keys Ctrl + 

F3).  From the Name Manager dialogue box select the range to be deleted and click on the 

Delete command.  To edit a name it to include a different cell reference range click on the Edit 

command and select the correct range.  

USE GO TO WITH NAMES 

As mentioned previously a name can be used to 

quickly access a cell or range of cells from anywhere in 

the workbook using the drop down on the name box. 

In addition the Go To shortcut dialogue box can be 

used to access names. To use this feature use the 

shortcut keys Ctrl + G, this will open the Go To 

dialogue box, select the required name, click OK and 

the name is highlighted.  
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NAMING CELLS FOR A RANGE, UNION OR INTERSECTION 

To name a range of cells for a Range, Union or Intersection reference use the normal method of 

highlighting the cells and clicking in the name box and naming the cells.  

NAMING CELLS FOR A 3D RANGE 

To name a 3D Range of cells the method is different, because 3D named range spans more than 

one worksheet the Name Manger dialog box must be used and not the Name Box.  

In the Name Manager click on the New command 

and this will open the New Name dialogue box. To 

select the range use the Refers to: launch button to 

manually select the ranges.  

 

Select the required cell range and then holding the Shift button select each of the required 

worksheets.  Then return to the New Name dialogue box with the launch button.  The 3D Range 

will show in the Refers to: box, showing the range of the sheets! and the absolute cell reference 

of the selected cells. 

It is important to note that the new 3D Range will show in the Name Manager but will not appear 

in the Name Box, however the 3D Range can be used in formula as a normal named group of 

cells.  

Example: Months Totals across 3 Worksheets.  

The totals for Jan, Feb and March have been 

set to a 3D Range named Months to add all 

three a SUM formula has been used.  
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5. OUTLINES 

CREATE OUTLINES 

Outlining is used to group and summarise a list of data to 

help make the data easier to understand. It can be used 

to organise data, hide data from view, show only certain 

data and for subtotaling lists. Up to 8 groups can be 

applied to outlined data.  

To use Outlines first the data must be complete and sorted according to the data to be outlined. 

In the example we will use the data is sorted according to the T-Shirt Size column as this column 

will be counted.  

To access outlines (ensure your mouse is clicked into the data list to be outlined, then) go to the 

Data tab to the Outline group and click on the Subtotal command. This will open the Subtotal 

dialogue box.  

 

In the At each change in: select the column which is being 

used for the outline (the sorted column).  

Under Use function: choose the function relating to the 

result required. In this example a total of T-Shirt sizes is 

required so Count is selected.  

Finally at Add subtotal to: select the column the subtotal 

will appear in, in this example it is the T-Shirt Size column.  

 

 

This creates an outline of the contents of the list of data as shown.  
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T-SHIRT SALES – OUTLINED DATA 
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WORK WITH OUTLINES 

When the data has been outlined the groups can be shown or hidden by the minus or plus 

symbols to the left of the row headings (numbers). The data can also be displayed by level just 

below the name box. Experiment with these options and the Subtotal dialogue box to 

understand how Outlines work.  

REMOVE AN OUTLINE 

To remove an outline click in the data and go to the Data tab to the Outline group, select the 

Subtotal command and from the Subtotal dialogue box select the Remove All command.  

Outlined data can be grouped and ungrouped as required in columns or in rows. For more 

information on Outlines view the GCF Learn Free Outline video. 

6. SCENARIOS 

CREATE SCENARIOS 

A Scenario in Excel is one of the three What-If Analysis tools. It can be used to determine 

possible results from a set of data by allowing the input values to be changed under different 

saved scenarios. The purpose of a scenario is to be able to store several sets of data possibilities 

in one cell.  

Example: Small Business Projected Sales 

In this example the projected Sales Target, Expense and Profit are shown for a small business 

over a period of six months. Three scenarios will be created: 

 The first will be the original projected sales for the business over the six months. 

 The second scenario will be figures 10% above the original scenario. 

 And the third scenario will be figures 10% below the original figures.  

  

http://www.gcflearnfree.org/excel2010/12.2
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ORIGINAL TARGET 

To create the first scenario which will be named 

Original Target, go to the Data tab to the Data 

Tools group and click on the What-If Analysis 

command button, from the drop down list 

select Scenario Manager…  In the Scenario 

Manager dialogue box select Add.  

 

 

 

From the Edit Scenario dialogue box set the 

Scenario name: and the Changing cells: 

(cells that will be changed) and click OK.   

 

 

 

 

 

In the Scenario Values dialogue box the 

values typed in the selected changing cells 

will automatically appear.  As this is the 

Original Target these values do not need to 

be changed at this time. Click OK to save this 

scenario.  
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10% ABOVE ORIGINAL TARGET 

In this example the second scenario will 

be one where the sales are 10% above 

the original target. Click on Add to create 

a new scenario  

Name the scenario and select the 

changing cells as shown.  

 

 

 

In this scenario where the figures are 

estimated at 10% above the original target a 

formula is applied in the Scenario Values 

dialogue box. The original figure is 

multiplied by 1.1 to get 110%. 

The formula are then converted to values 

and saved as the values for that scenario.  
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10% BELOW ORIGINAL TARGET 

Finally in the third scenario the sales are 

10% below the original target. Click on Add 

to create a new scenario.  

Again name the scenario and select the 

correct cell range (ensure the range is set 

to the original target before applying the 

10% less formula).  

 

 

In this scenario the formula used reduces 

the original target by multiplying it by 0.9%.  

Click ok to save the third scenario and 

convert the formula into values.  

 

 

USE, EDIT AND DELETE SCENARIOS 

When a scenario is applied the data in the 

worksheet is actually changed to that scenario.  

To Use or return to a specific scenario reopen the 

Scenario Manager, select the required scenario 

and select Show. 

To Edit or Delete a scenario, select the scenario 

and choose the appropriate command from the 

Scenario Manager.  
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ADD SCENARIOS TO THE QUICK ACCESS TOOLBAR 

After scenarios have been created they can be easily used from the quick access toolbar. Excel 

has provided a nice shortcut tool on the quick access toolbar and as new scenarios are created 

they are added to the shortcut.  

Open Excel Options, select Quick Access Toolbar, choose commands from All Commands, scroll 

down to Scenario and add the command to the quick access toolbar. Now all scenarios created 

for that worksheet are easily available from the quick access toolbar. 

 

  
NOTES:   
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CRETE A SCENARIO SUMMARY REPORT 

After the Scenario Manager has been used to create scenarios in Excel a summary report of each 

of these scenarios can be created.  This report displays not only the changing and resulting values 

for all the scenarios defined but also the current values in the changing cells in the workbook 

table at the time the report is generated.  

Access the Scenario Summary by going to the 

Data tab to the Data Tools group, open the 

Scenario Manger from the What-If Analysis 

group. In the Scenario Manager dialogue box click 

the Summary command button.  

From the Scenario Summary dialogue box select 

the cells with the results required for summary, in 

this example these are cells D8:D13 which show 

the Profit.  

 

The table below shows the completed Summary Report based 

on the different scenarios for the data and the outcomes in the 

Result Cells or the Profit column.  
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7. SORTING 

Sorting is used in worksheets to allow the data to be displayed in the order that is required by 

the user. This can be in ascending or descending, according to numerical or alphabetical order 

and can be applied to rows or columns.  

Sorting allows the user to see data in a structured way and to find values quickly. Sorting is also a 

pre-requisite to a variety of features in Excel such as Outlines and to some functions such as 

Lookups.  

TO SORT ON ONE COLUMN 

To sort information first click in any cell of the column the table is to be sorted by, 

then go to the Data tab to the Sort & Filter group and click on Sort A to Z or Sort Z to 

A command buttons.  The data will be automatically sorted according to the selected 

column.  

In this example the mouse was clicked in cell A11 before the sort, when the Sort A to Z sort was 

applied the result was that all the sports clubs were organised by Club in alphabetical order.  

 

 

 

 

 

 

 

 

  

Questions??? 

What happens when you highlight a whole column before you apply a sort?  

What does this mean?  

Why does this happen?   
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SORT ON MULTIPLE COLUMNS 

To sort a table according to several Columns the Sort dialogue box is used. To access it 

go to the Data tab to the Sort and Filter group and click on the Sort command button.   

The following example lists sales, the dates they were made, the staff member that made the 

sales and the amount of the sale. The data will be sorted by the Salesperson in alphabetical order 

and then by the Amount of the sales by largest to smallest.  

From the Sort by drop 

down list the column 

heading Salesperson is 

selected then the Order is 

set to A to Z. Then the 

Add Level command 

button is selected to 

allow a second level to be 

applied to this sort. In the second sort Then by the Amount is selected as the column and the 

Order is set to Largest to Smallest.  Ok is selected to apply the sort and the result is the sorted 

data shown below.  
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NOTE: Sorting call also be applied by font colour or cell icon. For more information on sorting 

watch the following Sorting video.  

SORT ON MULTIPLE ROWS 

Sorting data by Columns is the most common method of sorting; however data can also be 

sorted by Rows. To sort data by rows ensure the data is set up appropriately, in this example the 

data has the headings on the left side and each sale is organised down the column instead of 

across the row.  

In the following example the data will be sorted according the Salesperson and the Amount of 

the sale. To begin highlight only the data to be sorted – do not include the headings of the data.  

To access sorting by rows go to the Data tab to the Sort & Filter group and click on the Sort 

command button. In the Sort dialogue box click on the Options command button, to open the 

Sort Options dialogue box. To sort data according to rows choose the second option Sort left to 

right as shown below.  

http://office.microsoft.com/en-ie/excel-help/video-sort-data-VA101809992.aspx
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This will remove the option to sort the data according to column names and instead the sorting 

will be applied by row numbers. In the example above the data is sorted by Row 53 Salesperson 

and Row 54 Amount. Click on Ok to apply the sort and the result is the data sorted according to 

the rows as shown.  

CREATE SERIES AND CUSTOM LISTS  

SERIES 

Instead of entering data manually on a worksheet, the Auto Fill feature can be used to 

automatically fill cells with data, which follow a pattern or based on data in other cells. Series can 

be created based on numbers, dates or built in Custom Lists.  

Examples of Series are 1, 2, 3, 4, 5, 6 or 2, 4, 6, 8, 10 or 3, 6, 9, 12, 15. 

The Auto Fill feature is accessed by clicking 

on the Fill Handle (the small black square in 

the lower-right corner of the selection), 

when the cursor is pointed on the fill handle, 

the pointer changes to a black cross, as 

shown. Auto-fill can be applied to numbers, text, months, days and formulae.  

To create a series type in the starting value in the first cell, in the next cell type a value which will 

establish the pattern. Highlight the cells containing these starting values. Then drag the fill 

handle across the range that needs to be filled.  

3 Examples  

Note: To fill in increasing order, 

drag down or to the right.  To fill in 

decreasing order, drag up or to the 

left.   
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The following table shows a variety of different series which are automatically available in Excel.  

 

CUSTOM LISTS 

Custom Lists are pre-set series in Excel which are applied when the auto fill handle is dragged to 

other cells. To access Custom Lists to view all the available list go to Excel Options to the 

Advanced menu, scroll down to the General section and click on the command button Edit 

Custom Lists, this will open the 

Custom Lists dialogue box.  

From here all the available Custom 

Lists can be seen, new custom lists 

can be added and custom lists that 

are not required can be deleted.  

To apply custom lists type the 

starting value and use the auto fill 

handle, click on the box and drag 

down or across to apply the list.    
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SORT BY A CUSTOM LIST 

Custom Lists can also be used to sort data, in the following table the Sales information could be 

sorted several different ways for example by the month under the Delivery column by ascending 

or descending sort or by the Priority. For this scenario the sort will be applied by the Priority 

column by High, Medium and then Low. This is not alphabetical, however a custom list can be 

created for this order and then the data can be sorted by this custom list.  

 

 

 

 

 

 

 

 

First the Custom List is created from the Custom List dialogue box as shown on the previous 

page. Type the list in the required order into the List entries: box. Then click on the Add 

command button. Then click Ok and Ok.  
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The sorting is then applied by going to the Data tab, to the Sort & Filter group and clicking on the 

Sort command button. In the Sort dialogue box set the Column to Priority and the Order to the 

custom list High, Medium, Low as shown.  

 

 

 

 

 

 

 

The result is the data sorted according to the Priority with the High first, Medium second and 

finally the Low priority sales.  

 

 

For an alternative example on Sorting by a Custom List visit www.techrepublic.com. 

  

  

http://www.techrepublic.com/blog/10-things/10-steps-to-creating-a-custom-list-for-sorting-in-excel/
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8. TEMPLATES 

CREATE A TEMPLATE 

Templates are predesigned professional documents which have already been created and are 

available for reuse. All of the formatting in templates is complete and all that is required by the 

user is too add their own details. Examples of predesigned templates include calendars, invoices, 

receipts and financial reports. These are available both in the Excel software and online.  

FROM A PREDESIGNED TEMPLATE 

To create a template for an invoice from a predesigned template, go to File and select New from 

the dropdown menu. From here select the type of template required, in this example Invoices 

has been selected then Sales Invoice and the style choosen is Service invoice (Simple Blue 

design).  

 

This template invoice is 

automatically created and can 

now be edited according to 

the needs of the company. 

There is no limit to the 

formatting that can be applied 

to a template.  
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FROM A PERSONAL DESIGN 

A template can also be created from a document created by the user.  This document can be set 

up in any style with formatting or information required by the company, such as an invoice 

layout (with formula), or company logo, already saved into it. By saving the document as a 

template it can be easily reused again for future workbooks.  

To save a file as a template, first 

set up the formatting required in 

the Excel document. Then go to 

File and select Save As, in the 

Save as dialogue box choose 

Excel Template from the Save as 

type: dropdown list. Name the 

template in the File name: box 

with an appropriate name to 

allow the document to be easily 

recognised for future use.  

 

The file location will change to the default Template 

folder for the computer.  Using this folder will enable the 

computer will find the file automatically when creating a 

new template in the future.   

Note: Changing this location to a USB for example will 

allow the user to remove the template from the 

computer, however Word will not find this template 

automatically when a new template is created.  

  
Question? 

 

What is the difference in saving a template as an Excel Workbook or as an Excel Template?   
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USE A TEMPLATE PREVIOUSLY CREATED AND SAVED 

To use a template that has been created go to the File menu and then to New 

and select the My Templates command button. This will open the templates 

folder showing all templates created on this computer and saved to the My 

Templates folder.  

 

To use the template 

select it and click on 

the Ok command 

button.  

 

 

 

 

 

Additional templates can also be accessed from the Recent Templates 

and the Sample Templates options on the new menu.  

 

EDIT A TEMPLATE 

To Edit a Template and change its design, make the required changes to the template and 

ensure when saving these changes that it is saved as an Excel template. This will ensure the new 

changes to the template are available from future use.  

Normal saves to a document created from a template should be saved as an Excel Workbook. 

  



Section 3: Worksheet Features 

 

 

 
Page 43 

 
  

These notes have been compiled by Rynagh McNally for students of Monaghan Institute.  

9. REFERENCES 

WEBSITES:  

Advanced Filtering – for more information visit the YouTube channel Excel is Fun 

by Mike Girvin.  

Auto filtering - to view a video on auto filtering follow this link: office.microsoft.com   

Filtering – for more information visit office.microsoft.com.   

Hyperlink function – for more information visit office.microsoft.com. 

Linking between workbooks – for more information visit office.microsoft.com. 

Naming Cells and ranges – for more information visit office.microsoft.com. 

Outlines – for more information visit GCFLearnFree.org. 

Sort by a Custom List – for more information visit www.techrepublic.com. 

 

 

 

NOTES:  

http://www.youtube.com/watch?v=SU1qGbN6Rs8
http://office.microsoft.com/en-ie/excel-help/video-filter-data-by-using-an-autofilter-VA101809989.aspx?CTT=5&origin=HA010370616
http://office.microsoft.com/en-ie/excel-help/filter-data-in-a-range-or-table-HP010073941.aspx
http://office.microsoft.com/en-ie/excel-help/hyperlink-function-HP010342583.aspx
http://office.microsoft.com/en-ie/excel-help/create-an-external-reference-link-to-a-cell-range-in-another-workbook-HP010342364.aspx
http://office.microsoft.com/en-ie/excel-help/define-and-use-names-in-formulas-HA010147120.aspx
http://www.gcflearnfree.org/excel2010/12.2
http://www.techrepublic.com/blog/10-things/10-steps-to-creating-a-custom-list-for-sorting-in-excel/

